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Abstract: The Automatic Ventilator is a controllable, automated add-on solution to the existing and widely available 

Bag Valve Mask. The device compresses the BVM with a mechanical system that is able to provide consistent and 

accurate ventilation with positive-pressure. This solution exists within the top range of high-acuity limited-operability 

(HALO) ventilator solutions with an a priori design to produce volume and pressure cycled ventilation that includes 

positive end-expiratory pressure (PEEP) and enriched oxygen sources. In this situation of COVID 19, many people are 

being exposed to corona virus, resulting in difficulty in breathing and a drop in oxygen percentage of blood. A mechanical 

ventilator is playing a vital role in tackling this situation but the ventilation process is neither readily available nor 

affordable. The idea behind this work is to propose a simplified design of a mechanical ventilator to reduce the cost and 

automate the Mechanical ventilation process. The simplified design, it's working, and required components are elaborated 

in this paper. The simulation of the proposed design is made in MATLAB/Simulink platform which is also discussed 

below. Simulation results are promising and precise which allows the study on ventilator model without jeopardizing the 

life of human subjects as in clinical approach and hides the complexity of computational models from the user. 

Furthermore, advancements in this model are done by the machine learning approach.: Successful weaning from 

prolonged mechanical ventilation (MV) is an important issue in respiratory care centers (RCCs. This study aims to utilize 

artificial intelligence algorithms to build predictive models for the successful timing of the weaning of patients from MV 

in RCCs and to implement a dashboard with the best model in RCC settings. A total of 670 incubated patients in the RCC 

in Chi Mei Medical Center were included in the study. Twenty-six feature variables were selected to build the predictive 

models with artificial intelligence (AI)/machine-learning (ML) algorithms. An interactive dashboard with the best model 

was developed and deployed. A preliminary impact analysis was then conducted. Our results showed that all seven 

predictive models had a high area under the receiver operating characteristic curve (AUC), which ranged from 0.792 to 

0.868. The preliminary impact analysis revealed that the mean number of ventilator days required for the successful 

weaning of the patients was reduced by 0.5 after AI intervention. The development of an AI prediction dashboard is a 

promising method to assist in the prediction of the optimal timing of weaning from MV in RCC settings. However, a 

systematic prospective study of AI intervention is still needed. 
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I. INTRODUCTION 
 

The Automatic Ventilator is an automated bag valve mask (BVM) device utilizing off-the-shelf components to provide 

safe and continuous hospital- grade mechanical ventilation for COVID-19 patients on an open-source basis. The BVM 

is a controllable, automated add-on solution to the existing and widely available Bag Valve Mask. The device compresses 

the BVM with a mechanical system that is able to provide consistent and accurate ventilation with positive-pressure. This 

solution exists within the top range of high- acuity limited-operability (HALO) ventilator solutions with an a priori design 

to produce volume and pressure cycled ventilation that includes positive end-expiratory pressure (PEEP) and enriched 

oxygen sources. Controls of the BVM are familiar and clinician-designed with adult, child, and pediatric settings. 
 

II. LITERATURE SURVEY 
[ 

Noninvasive Breathing Effort Estimation of Mechanically Ventilated Patients Using Sparse Optimization [1].Mechanical 

ventilators facilitate breathing for patients who cannot breathe (sufficiently) on their own. The aim of this paper is to 

estimate relevant lung parameters and the spontaneous breathing effort of a ventilated patient that help keeping track of 

the patient’s clinical condition. A key challenge is that estimation using the available sensors for typical model structures 

results in a non-identifiable parameterization. A sparse optimization algorithm to estimate the lung parameters and the 

patient effort, without interfering with the patient’s treatment, using an -1-regularization approach is presented. It is 

confirmed that accurate estimates of the lung parameters and the patient effort can be retrieved through a simulation case 

study and an experimental case study. DIY Ventilator using Arduino with Blood Oxygen Sensing for Covid Pandemic 

[2].This paper portrays outline of different examination done. The human lungs are utilized for breaths.  
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They use push system in every breath motivation and exhalation 4 process happens. The DIY ventilator here we 

configuration is help individuals during Covid pandemic. It is exceptionally modest and reasonable at the point when 

patients experience the ill effects of lung breathing issue this can be utilized in a patient basic condition. Stepper Motor 

component is utilized to push the ambo sack. While breathing heartbeat level identified are low this component can be 

performed. The LED screen is utilized to show the breathing heartbeat levels. Likewise, in a patient basic condition or 

breathing issue ringer is fitted in the Frame work to sound a ready and any irregularities are identified. Aside from option 

to screen the patient's blood oxygen level and breathed out lung strain to keep away from over/under air tension at the 

same time. Review on DIY Ventilator using Arduino with Blood Oxygen Sensing for Covid Pandemic [3].This paper 

describes overview of various research done. Human lungs use lungs for respiration. They use push mechanism in each 

breath. Inhalation and exhalation process take place. The ventilator here we design is to help people during Covid 

Situation. It is very cheap and affordable. Motor mechanism is used to push the air bag. At the point when oxygen level 

counts are low this mechanism can be performed little screen is used to display. The entire system is driven by an Arduino 

microcontroller and a buzzer is fitted to detect any low levels of oxygen count. 

 

Low-Cost, Open-Source Mechanical Ventilator with Pulmonary Monitoring for COVID-19 Patients [4].This paper shows 

the construction of a low-cost, open-source mechanical ventilator. The motivation for constructing this kind of ventilator 

comes from the worldwide shortage of mechanical ventilators for treating COVID-19 patients the COVID-19 pandemic 

has been striking hard in some regions, especially the deprived ones. Constructing a low-cost, open-source mechanical 

ventilator aims to mitigate the effects of this shortage on those regions. The equipment documented here employs 

commercial spare parts only. Experiments carried out in the laboratory that had emulated healthy and unhealthy patients 

illustrate the potential benefits of the derived mechanical ventilator. Design and Development of a Low-Cost Automatic 

Ventilator Presentation [5].Total 1,769 ventilators in Bangladesh, which means an average of one ventilator available for 

every 93,273 persons. The most pressing shortages facing hospitals during the COVID-19 emergency is a lack of 

ventilators. These machines can keep patients breathing when they no longer can on their own and they can cost around 

$30,000 each. Based on calculation, 12 Respiratory rate (RR)/min can provide required amount of tidal volume to the 

pneumonia patient. Strategy of automatic arm actuated BVM compression is proven to be a viable option to achieve low  

cost, low-power and portable ventilator technology that provides essential ventilator features at a fraction of the cost of 

existing models. 
 

III. PROPOSED SYSTEM 
 

This project Automatic Ventilator is based on the wired technique with motion in forward, reverse direction of DC motor. 

From the DC Motor we press the Bag Valve Mask (BVM) and get control on it to provide the automatism to BVM.The 

aim is to provide ventilator in emergency pandemic situation by which we can save many lives to provide them a right 

time ventilator support. By digital thermometer and oxi-pulse meter we can observe on time patient heart bit and 

temperature record by which can provide effective treatment to patient. Idea behind 2 this work is to control the motor 

rotation and effective use of Bag Valve Mask (BVM) which is controlled Arduino. This Automatic Ventilator helps 

patient to provide them right time ventilator support without any human. Our aim is to provide low cost ventilator by 

which it will be available in every hospital.   
 

Block Diagram 
 

 
Fig.1.Block Diagram of Automatic Ventilator 
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Fig.1.1. Experimental setup of Automatic ventilator 
 

IV. HARDWARE REQUIREMENTS 
 

1. DC geared Motor  

2. Arduino UNO  

3. Adapter  

4. 128x32 OLED Display  

5. Bag valve mask(BVM) 

6. Vega temperature kit  

7. Max30102 sensor 

8. Heart beat Sensor 

9. IoT Board 

10. Power supply  
 

1. DC motor 
 

DC motor is any of a class of rotary electrical motors that converts direct current electrical energy into mechanical energy. 

The most common types rely on the forces produced by magnetic fields. Nearly all types of DC motors have some internal 

mechanism, either electromechanical or electronic, to periodically change the direction of current in part of the motor. 
 

2. Arduino Uno 
 

It is a microcontroller board based on 8-bit ATmega328P microcontroller. Along with ATmega328P, it consists other 

components such as crystal oscillator, serial communication, voltage regulator, etc. to support the microcontroller. 

Arduino Uno has 14 digital input/output pins (out of which 6 can be used as PWM outputs), 6 analog input pins, a USB 

connection, A Power barrel jack, an ICSP header and a reset button.  

 

 
 

Fig.2.Arduino Uno 2D Model 
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Communication of Arduino  
 

Arduino can be used to communicate with a computer, another Arduino board or other microcontrollers. The 

ATmega328P microcontroller provides UART TTL (5V) serial communication which can be done using digital pin 0 

(Rx) and digital pin 1 (Tx). An ATmega16U2 on the board channels this serial communication over USB and appears as 

a virtual com port to software on the computer. The ATmega16U2 firmware uses the standard USB COM drivers, and 

no external driver is needed. However, on Windows, a.inf file is required. The Arduino software includes a serial monitor 

which allows simple textual data to be sent to and from the Arduino board. There are two RX and TX LEDs on the 

arduino board which will flash when data is being transmitted via the USB-to-serial chip and USB connection to the 

computer (not for serial communication on pins 0 and 1). A Software Serial library allows for serial communication on 

any of the Uno's digital pins. The ATmega328P also supports I2C (TWI) and SPI communication. The Arduino software 

includes a Wire library to simplify use of the I2C bus. 
 

3. Adapter 
 

An adapter is a physical device that allows one hardware or electronic interface to be adapted (accommodated without 

loss of function) to another hardware or electronic interface. In a computer, an adapter is often built into a card that can 

be inserted into a slot on the computer's motherboard. The card adapts information that is exchanged between the 

computer's microprocessor and the devices that the card supports. The power supply unit is the piece of hardware that's 

used to convert the power provided from the outlet into usable power for the many parts inside the computer case. It 

converts the alternating current (AC) into a continuous form of power called direct current (DC) that the computer 

components need in order to run normally. It also regulates overheating by controlling voltage, which might change 

automatically or manually depending on the power supply. 
 

4. 128x32 Graphic I2C OLED Display 
 

Winstar WEO012832F is a popular small OLED display which is made of 128x32 pixels, diagonal size 0.91 inch, it's 

very suitable for wearable device. The WEO012832F has the same mechanical dimension as WEO012832D but having 

different pin assignment and supports different interface. WEO012832F module is built in with SSD1306 controller IC; 

it supports I2C interface and having 14 pins FPC pin out. As to the WEO012832D module is also built in with SSD1306 

IC but it communicates via SPI interface and having 15 pins FPC pin out. 

 
Fig.3.128x32 Graphic I2C OLED Display 

 

WEO012832F is a COG structure OLED display, its controller is built-in voltage generation only need a single 3V power 

supply. This OLED I2C Display is lightweight, low power and small, this COG module is suitable for wall / meter 

devices, home applications, Cloud/IoT system, handheld instruments, intelligent technology devices, energy systems, 

automotive, communication systems, medical instrument, wearable device, etc. WEO012832F OLED module can be 

operating at temperatures from -40℃ to +80℃; its storage temperatures range from -40℃ to +85℃. 
 

5. Bag valve mask 
 

Bag-valve-mask (BVM) ventilation is an essential emergency skill. This basic airway management technique allows for 

oxygenation and ventilation of patients until a more definitive airway can be established and in cases where Endo-tracheal 

intubation or other definitive control of the airway is not possible. For the emergency medical technician, basic BVM 

ventilation is most often the only option for airway management. In the pediatric population, BVM may be the best option 

for pre-hospital airway support. BVM ventilation is also appropriate for elective ventilation in the operating room (OR) 

when intubation is not required, but it is now often replaced in this setting by the laryngeal mask airway. various sizes 

e.g. Laerdal 240mL,500mL, 1600 mL bag sizes for infants, children and adults. Oxygen inlet nipple. Air intake valve . 

Non-Rebreathing valve that directs fresh flow of oxygen to the patient and prevents exhaled gas re-entering the bag. 

Oxygen reservoir with two one way valves.  
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Fig.4.Bag Valve Mask (BVM) 

 

Reservoir is at least the volume of the bag. Oxygen flow rate equal to, or higher than, the minute volume of the patient 

allows 100% oxygen to be delivered – Inlet valve allows room air to enter if fresh gas flow is inadequate and an outlet 

valve allow oxygen to flow out if pressure is excessive. Standard 15 mm adapter for attaching to masks or tubes Able to 

attach PEEP valve to exhalation port (either “built in” or detachable).Can hold down pop off valve (releases at about 60 

cmH2O) to give increased pressure in the circuit. Masks come in a range of sizes and designs.  Opaque or clear plastic. 

Firm or air inflated cushion. Mouldings vary but are designed to minimize dead space and fit Some have specific names 

(e.g. Rendall Baker Mask for paediatrics). 
 

6.Temperature sensor kit:  
 

DS18B20 is 1-Wire digital temperature sensor from Maxim IC. Reports degrees in Celsius with 9 to 12-bit precision, 

from -55 to 125 (+/-0.5). Each sensor has a unique 64-Bit Serial number etched into it - allows for a huge number of 

sensors to be used on one data bus. 
 

7.Max30102 sensor:   
 

The MAX30102 is an integrated pulse oxy meter and  heart rate monitor module. It includes internal LEDs, photo 

detectors, optical elements, and low-noise electronics with ambient light rejection. The MAX30102 provides a complete 

system solution to ease the design-in process for mobile and wearable devices. Maxim Integrated MAX30102 Sensor is 

an integrated pulse oxy metre and heart- rate monitor module. The MAX30102 includes internal LEDs, photo detectors, 

optical elements, and low-noise electronics with ambient light rejection. This highly sensitive device operates on a single 

1.8V power supply and a separate 5.0V power supply for the internal LEDs. Communication is through a standard I2C- 

compatible interface. This sensor can be shut down through software with zero standby current, allowing the power rails 

to remain powered at all times. 
 

 
 

Fig.5.Max30102 Sensor 
 

V. SOFTWARE REQUIREMENTS 
 

1. Arduino IDE  

2. Embedded C language  

3. Android Application  
 

Arduino IDE 
 

The Arduino integrated development environment (IDE)  

is a cross- platform application (for Windows, Mac OS, Linux) that is written in the programming language Java. It is 

used to write and upload programs to Arduino compatible boards, but also, with the help of 3rd party cores, other vendor 
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development boards .The source code for the IDE is released under the GNU General Public License, version 2. The 

Arduino IDE supports the languages C and C++ using special rules of code structuring. The Arduino IDE supplies a 

software library from the Wiring project, which provides many common input and output procedures.  
 

User-written code only requires two basic functions, for starting the sketch and the main program  loop, that are compiled 

and linked with a program stub main() into an executable cyclic executive program with the GNU tool chain, also 

included with the IDE distribution. The Arduino IDE employs the program argued to convert the executable code into a 

text file in hexadecimal encoding that  is loaded into the Arduino board by a loader program in the board's firmware 
 

Example: 

Double num = 45.352 ;// declaration of variable with type double and initialize it with 45.352. 
 

 In this section, we will learn in easy steps, how to set up the Arduino IDE on our computer and prepare the board 

to receive the program via USB cable. 
 

Step 1: First you must have your Arduino board (you can choose your favorite board) and a USB cable. In case you use 

Arduino UNO, Arduino Duemilanove, Nano, Arduino Mega2560, you will need a standard USB cable (A plug to B 

plug), the kind you would connect to a USB printer as shown in the following image. 

 

 
Fig.6. USB Cable 

Step 2: Download Arduino IDE Software. 
 

 You can get different versions of Arduino IDE from the Download page on the Arduino Official website. You 

must select your software, which is compatible with your operating system (Windows, IOS, or Linux). After your file 

download is complete, unzip the file. 
 

 
 

Step 3: Power up your board. 
 

 The Arduino Uno, Mega, Duemilanove and Arduino Nano automatically draw power from either, the USB 

connection to the computer or an external power supply. If you are using an Arduino Diecimila, you have to make sure 

that the board is configured to draw power from the USB connection. The power source is selected with a jumper, a small 

piece of plastic that fits onto two of the three pins between the USB and power jacks. Check that it is on the two pins 

closest to the USB port. Connect the Arduino board to your computer using the USB cable. The green power LED 

(labeled PWR) should glow. 
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Step 4: Launch Arduino IDE. 
 

 After your Arduino IDE software is downloaded, you need to unzip the folder. Inside the folder, you can find 

the application icon with an infinity label (application.exe). Double click the icon to start the IDE. 

 

 
Step 5: Open your first project. 
 

Once the software starts, you have two options: 

• Create a new project. 

• Open an existing project example. 

To create a new project, select File --> New. To open 
 

 
 

To open an existing project example, select File -> Example -> Basics -> Blink. 
 

 
 

Here, we are selecting just one of the examples with the name Blink. It turns the LED on and off with some time delay. 

You can select any other example from the list. 
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Step 6: Select your Arduino board. 

 To avoid any error while uploading your program to the board, you must select the correct Arduino board name, 

which matches with the board connected to your computer. 
 

Go to Tools -> Board and select your board 

 
 

Here, we have selected Arduino Uno board according to our tutorial, but you must select the name matching the board 

that you are using 
 

Step 7: Select your serial port. 
 

Select the serial device of the Arduino board. Go to Tools ->Serial Port menu. This is likely to be COM3 or higher 

(COM1 and COM2 are usually reserved for hardware serial ports). To find out, you can disconnect your Arduino board 

and re-open the menu, the entry that disappears should be of the Arduino board. Reconnect the board and select that serial 

port. 

 
 

Step 8: Upload the program to your board. 
 

 Before explaining how we can upload our program to the board, we must demonstrate the function of each 

symbol appearing in the Arduino IDE toolbar. 
 

 
A- Used to check if there is any compilation error. 

B- Used to upload a program to the Arduino board. 

C- Shortcut used to create a new sketch. 

D- Used to directly open one of the example sketch. 

E- Used to save your sketch. 

F- Serial monitor used to receive serial data from the board and send the serial data to the board. 
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Now, simply click the "Upload" button in the environment. Wait a few seconds; you will see the RX and TX LEDs on 

the board, flashing. If the upload is successful, the message "Done uploading" will appear in the status bar. 
 

Note: If you have an Arduino Mini, NG, or other board, you need to press the reset button physically on the board, 

immediately before clicking the upload button on the Arduino Software. 
 

Arduino programming structure 
 

 In this chapter, we will study in depth, the Arduino program structure and we will learn more new terminologies 

used in the Arduino world. The Arduino software is open-source. The source code for the Java environment is released 

under the GPL and the C/C++ microcontroller libraries are under the LGPL. 
 

Sketch: The first new terminology is the Arduino program called “sketch”. 
 

Structure 

 Arduino programs can be divided in three main parts: Structure, Values (variables and constants), and 

Functions. In this tutorial, we will learn about the Arduino software program, step by step, and how we can write the 

program without any syntax or compilation error. 
 

Let us start with the Structure. Software structure consist of two main functions: 

• Setup( ) function 

• Loop( ) function 

 
 

VI. FUTURE SCOPE 
 

Emergency use of automatic ventilator is very useful in covid19 pandemic for the patient. The best thing which make it 

more useful is the Low Cost by which it will available in every hospital as well as clinics. Now days as we know that 

there is lack of ventilator in hospitals in this pandemic situation because of the higher cost. Govt. also not able to provide 

more ventilator for the patient. So in future if we will use this prototype for creating an automatic ventilator at the low 

cost then it will very useful for the patient and easily available in the hospitals. The advantages of this ventilator are End-

to-end clinician-informed design inclusive of all critical engineering touch-points , Control systems that are designed for 

positive pressure. Price target under 3k and components allow for an entirely disposable unit, Hot-swappable parts and 

power sourcing, with an easily controllable mechanical junction, Fully constructed from DIY components and readily 

available parts  

VII. CONCLUSION 
 

Due to Covid-19 which has become pandemic, a country like India is facing shortage of ventilators, we tried an 

affordable, cost effective automatic ventilator to be available in the market. The major applications of this ventilator are 

Mechanical ventilation, On time Heart rate +oxy pulse meter , On time body Temperature detector. We employed AI 

technology to develop a comprehensive system and embedded it into the existing HIS to predict the timing of weaning 

MV; this proves the clinical innovation of AI intervention in critical care. According to our knowledge, such a study with 

valuable academic and practical implications is rare. Most studies only report the quality of predictive models; thus, it 

may be difficult to judge its actual clinical value. Our study established a predictive model and validated the model in the 

clinical field, which proved that it has better benefits than traditional ones. Although we can see that the AI prediction 

dashboard we proposed can be an effective tool to assist weaning decision making, it should be noted that it cannot be 

regarded as the only dependence for final decision-making. That is, after referring to the AI’s prediction, the medical 

team still need to conduct and discuss a professional and comprehensive observation and evaluation of the patient again 

before making the final weaning decision. Our study showed that the use of ML approaches could obtain better predictive 

ability in ICU, however, some physicians also reported that AI assistance is not very necessary. Thus, how to increase 

physicians’ willingness to accept AI is indeed a key research topic. Besides, AI algorithms are difficult to understand 

(so-called black-box), which may affect the trust of clinical staff.  
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Therefore, follow-up research to improve the explain ability of AI must be done. Furthermore, intensivists expect that AI 

can be applied to build a decision support tool for integrated consideration of a patient rather than simply providing 

predictions on an illness. This is a challenge that should be taken seriously. However, we still have a long way to go at 

this moment. Mechanical Ventilation is a very critical and delicate process that needs to be done precisely as a single 

mistake can cost the patient his/her life. Thus, the operation is done by skilled professionals or therapists and the on-time 

decisions taken are mostly based on experience. Thus, automating the process is very beneficial as it can control the 

modes and parameters according to the conditions and training neural networks. Simulation and computational models 

can mimic the real-life medical clinical situation and thus reduce the human intervention by assisting the medical 

professionals with its wide range of functionality and usage. Simulation is becoming an essential field in biomedical 

engineering and can be used not only for treatment but also for experimenting on diseases or patients.  

 

The same is applied to a mechanical ventilator and the human respiratory system. The MATLAB/ Simulink model 

simulates the interaction between human lungs and mechanical ventilators. Thus, operations could be performed on it 

and results could be seen on the graphical interface provided which will help therapists to make informed decisions. 

Mechanical ventilators used currently are very complex which leads to an increase in the cost of the ventilation process. 

Thus, simplification of the design, simulation, and artificial intelligence approach will reduce the cost. Introducing 

Mechanical Ventilator to artificial intelligence can provide it with decision-making ability which is absent in normal 

Ventilators. This can save the lives of physicians and respiratory therapists from contagious respiratory diseases like 

Covid-19.The simulation model has graphical features similar to a mechanical ventilator which eases the human-

ventilator interaction. The system covers about every parameter and function provided by the actual ventilator along with 

a complex model of the respiratory control system. The tool has shown promising results and can be used for training 

purposes. The system completely validates the experimental data taken from an actual mechanical ventilator. More 

functions and modes can be added to make the model more precise. Currently, our work is more focused on optimizing 

the model with the artificial neural network to provide it the decision-making ability. 
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